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1. Browser support and recommended settings 

Notes to CatExpress users 

OCLC Connexion browser is the cataloging system of which CatExpress is a part. CatExpress operates 
within the Connexion environment, so you use Connexion to access and use CatExpress. 
Requirements and recommendations for Connexion apply also to CatExpress. 

However, examples of possible problems may mention advanced cataloging functions of Connexion 
that are not available to CatExpress subscribers. 

Browser support 

Browser Recommended Notes 
Internet Explorer Version 11 Version 11 for Windows 7, 8.1, and 10. 
Firefox Current version   

 

Unsupported browsers 

The following browsers are not supported for use with the OCLC cataloging system: 

• Apple® Safari for Macintosh or Safari for Windows 
• Google® Chrome 
• Opera 
• AOL (America Online) 
• Lynx 

Browser navigation buttons 

Browser button Notes 
Back 
Forward 

Do not use. 
• Move among system screens using only the tabs, 

buttons, keystroke shortcuts, and other navigation 
features provided in the Connexion interface. 

Stop Do not use. 
• The browser’s Stop button cannot cancel actions 

because, in most cases, the action is sent immediately 
to the server. The use of the stop button can also cause 
display problems. 

 

 

 

Cache settings for best performance 

About cache settings 
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• Browser cache settings determine how your browser handles redisplaying Web pages you have 
previously viewed. 

• The browser may display the page as it exists in temporary storage (the browser’s cache area) 
or download the latest version of the page from the server. 

• Using the commended settings can improve browser performance by instructing the browser to 
display stored pages, rather than downloading fresh pages from the server, when revisiting a 
site. 

• Note: Your browser may already be configured to the recommended settings. Many of these 
settings are defaults. 

Recommend settings 

• Set your browser to refresh Web pages automatically when necessary. Do not specify that the 
browser refresh a page each time you view it. 

• Allocate adequate disk space for the browser cache. 10 MB is recommended. Do not specify 
zero space for the cache, and avoid allowing it to be larger than 50 MB. 

• Do not configure Internet Explorer to clear the cache each time you exit the browser. 
• Retain the browser’s History (log of recently visited sites) for 4 days. 

Notes on cache size 

• By default, recent versions of Internet Explorer assign a very large value for cache size. In some 
cases, it may be 200 MB or higher. Unless you regularly download many large video or Flash 
files, we recommend that you reduce the value for ‘Amount of disk space to use’ to 10 MB. This 
is more than sufficient for most users and greatly reduces browser overhead for maintaining the 
cache. 

• Firefox defaults to between 5 and 50 MB of cache. You can accept their defaults unless you 
experience performance problems. To improve the performance, it may help to change the 
cache size to 10 MB. A cache that is too large often causes just as many problems as one that 
is too small.  

Before changing browser settings 

• The recommended settings many not work with certain network security configurations or with 
some web-based applications. 

• If you experience problems with Connexion browser or with other web-based applications when 
using the recommended cache settings, see the section titled Resolve caching problems (later 
in this topic). 

• Before changing cache/history settings, write down your current settings so that you can restore 
them if the new settings cause problems. 

 

 

Browser Setup instructions 
Internet 
Explorer 

1. On the Tools menu, click Internet Options. 
2. On the General tab, under Temporary Internet Files, click the Settings button. 
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3. In the Settings dialog box, under Check for newer versions of stored pages, 
click Automatically. 

4. Under Amount of disk space to use, type 10 in the text box. 
5. Then click OK to close the Settings dialog box. 
6. On the General tab, under History, for Days to keep pages in history, type 4 in 

the text box. 
7. On the Advanced tab, under Security (the last group of settings in the list), 

clear the check box labeled Empty Temporary Internet Files folder when 
browser is closed. 

8. Click OK to close the Internet Options dialog box. 
Firefox 1. On the Tools menu, click Options. 

2. In the Options dialog box, click Privacy. 
3. On the Privacy tab, in the History section, make sure the check box for 

Remember visited pages for the last ____ days is selected. To specify the 
number of days, type 4 in the text box. 

4. On the Privacy tab, in the Private Data section, make sure that the check box 
for Always clear my private data when I close Firefox is cleared (no check 
mark). 

5. Click OK to apply the change and close the Options dialog box. 
 

To specify how frequently the cache is refreshed: 
1. In Firefox, clear the URL shown in the address bar. Then type about:config 

and press <Enter>. 
2. In the Filter box, type cache to view the settings for cache-related 

preferences. 
3. For the first item listed, browser.cache.check_doc_frequency, keep the 

default setting, with the number 3 in the Value column. Note: This setting 
parallels the Automatically setting recommended for Internet Explorer. 
 

Caution: When using the about:config settings, be careful not to accidentally 
change one of the many other settings on the list. Firefox saves changes 
automatically when you go to another web page. 

 

Clear browser cache 

Note: JavaScript errors after a Connexion release 

• If you experience JavaScript errors immediately after a Connexion release, try refreshing 
affected pages first, or clear your cache once rather than changing your settings. 

• For best browser performance, do not clear the cache more often than necessary. 
• But to resolve problems immediately after an install, clearing the cache once may be helpful. 
• If clearing the cache does not solve a persistent caching problem, see the section titled Resolve 

caching problems (later in this topic). Symptoms of caching problems include: old data 
repeatedly appearing, check boxes not remaining selected, and changes not being retained. 
 
 Action 
1 Close all browser windows, including popups. This step is essential for the cache to be 

cleared completely. 
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2 Start just one browser window and navigate to a non-OCLC site such as Google or 
Yahoo. Do not start any other browser windows until after you complete the cache-
clearing process. 

3 Clear the cache. 
Internet Explorer: 
1. On the Tools menu, click Internet Options. 
2. On the General tab, under Browsing history, click the Delete button. In the Delete 

Browsing History dialog box, under Temporary Internet Files, click the Delete Files 
button. Then click OK. 

3. Click OK to close the options dialog box. 
Firefox: 
1. On the Tools menu, click Options. 
2. Click Privacy. 
3. In the Private Data section, click the Clear Now button. 
4. In the Clear Private Data dialog box, make sure Cache is selected. Select or clear the 

other check boxes as appropriate. 
5. Click the Clear Private Data Now button. 
6. Then click OK to apply the change and close the dialog box. 

4 Close, and then restart, the browser. Log on to Connexion browser. 
 

Resolve caching problems 

• If, after using previously recommended cache settings and occasionally clearing the cache, you 
observe caching problems, you may need to change cache settings to correct the problem. 

• Suggested changes. This section recommends that you set your browser to refresh pages 
every time you visit a page. Using the settings given in this section slows performance but can 
improve reliability when a workstation has a cache problem that causes the browser to display 
expired pages or incorrect data. 

• These settings should be compatible with other web-based applications, including the following 
OCLC services: FirstSearch and QuestionPoint. 

• Before changing cache settings. Before changing cache settings, write down your current 
settings so that you can restore them if the new settings cause problems. 
 
Browser  Setup instructions 
Internet 
Explorer 

1. On the Tools menu, click Internet Options. 
2. On the General tab, under Temporary Internet Files, click the Settings 

button. 
3. In the Settings dialog box, under Check for newer versions of stored 

pages, click Every visit to the page. 
4. Then click OK to close the Settings dialog box. 
5. On the General tab, under Temporary Internet Files, click the Delete 

Files button. In the Delete Files dialog box, select the Delete All 
Offline Content button. Then click OK. 

 
Browser  Setup instructions 
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 6. On the Advanced tab, under Security (the last group of settings in the 
list), select the check box labeled Empty Temporary Internet Files 
folder when browser is closed. 

7. Click OK to close the Internet Options dialog box. 
Firefox To refresh the cache each time you visit a page: 

1. With Firefox open, clear texts in the address bar. Then type 
about:config and press <Enter>. 

2. In the Filter box, type cache. 
3. Change the browser.cache.check.doc.frequency setting value to 1. 

Note: This setting corresponds to the Every visit to the page setting 
in Internet Explorer. 

4. To apply the change, close Firefox. Or go to another web address by 
clicking the Home button or typing a URL in the address bar. 

To clear the cache (and/or other data) when you close Firefox: 
1. On the Tools menu, click Options. 
2. In the Options dialog box, click Privacy. 
3. On the Privacy tab, in the Private Data section, select the check box 

for Always clear my private data when I close Firefox. 
4. In the Private Data section, click the Clear Now button. 
5. In the Clear Private Data dialog box, make sure Cache is selected. 

Select or clear the other check boxes as appropriate. All selected 
types of data will be cleared when you close Firefox. 

6. Then click OK to apply the change and close the dialog box.  
7. Click OK to apply the change and close the Options dialog box. 

 

Cookie options 

About cookies 

• A cookie is a message a web server sends to your browser. Usually, cookies store information 
the server uses to manage the session. When you close your browser, cookies that remain in 
memory are saved to a file on your hard disk. Internet Explorer saves individual text (*.txt) files 
in a cookies folder (locations vary with browser version and Windows version). 

• Connexion browser uses cookies to update the session timer and keep track of your current 
screen. Because they are constantly recycled, cookies occupy negligible space in memory or on 
your hard disk. 

• The timer function sends a cookie for each tick of the timer; each new cookie replaces the 
previous one. Each screen includes a small cookie in the HTTP header, but again the cookie 
overwrites the one sent with the previous screen. 

• Security/privacy. Cookies are not required to use this system. However, some useful optional 
features will not work correctly if you set your browser to reject cookies. Specifically, the session 
countdown timer and the session timeout warning may report incorrect times. Also, without 
allowing cookies, you cannot save your authorization and password to avoid entering these 
items each time you log on. Cookies used by this system pose very little security risk because, 
other than the optional authorization and password (which are encrypted), no other user 
information is captured. 
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Recommended settings 

• When first installed, both Internet Explorer and Firefox browsers are set to accept all cookies. 
• For best results when using Connexion, leave this setting unchanged. 

 
Check your cookie settings 
Browser To check cookie settings 
Internet 
Explorer 

1. On the Tools menu, click Internet Options. 
2. In the Internet Options dialog box, click the Privacy tab. 
3. Adjust the setting to Medium or Medium High. 
4. Click OK to close the Internet Options dialog box. 

Firefox 1. On the Tools menu, click Options. 
2. In the Options dialog box, click Privacy. 
3. In the Cookies section, make sure that Accept cookies from sites is 

selected (checked). If not, click the box to select the option. 
4. Click OK to close the Options dialog box. 

Note: Connexion does not use third-party cookies. You can clear the box for 
Accept third-party cookies if you do not visit sites that require them. 

 

Popup blocking software 

• Software that blocks the display of popup advertisements from Web sites can interfere with 
Connexion functions that open separate browser windows. Examples: label displays, the list of 
keystrokes, authority control, and Help. 

• For best results while using Connexion, turn off popup blocking software. 
• If you prefer to keep a popup blocker active, configure the software to allow popup windows 

from the domain oclc.org. 
 
If you experience problems with Connexion functions after configuring oclc.org as an 
exception, contact the vendor of your popup blocker for information on known problems that 
might affect its operation. 

Note: Popup blocking may be enabled on your workstation even if you have not installed a 
separate program for that purpose. Recent versions of browsers, security software, and other 
applications may include a popup-blocking tool or option. Add-on browser toolbars from search 
engines and portal sites, including the Google Search toolbar and the Yahoo Search toolbar, may 
also come with default popup blockers that need to be disabled. Before logging on to Connexion 
browser, verify that you have turned off all popup-blocking functionality on your workstation, or 
configured blocking to allow popups from the oclc.org domain. 

Download accelerator software 

• Software used to enable faster downloading of files through a Web browser can interfere with 
Connexion browser functions that involve downloading data to a file on your workstation. 

• For best results, before exporting records to a file or creating labels for bibliographic records, 
turn off any download accelerator software you have installed. 
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Delayed response: do not repeat action 

• Do not click again on a button or link, or repeat a shortcut keystroke, while the system is still 
processing an action. 

• Repeating an action while the system is processing your first request actually slows completion 
of the requested action. The second click or keypress cancels the initial request; processing 
starts over from the beginning. 

• The system may not respond immediately when you start a search, switch record views, or take 
action on a record. The specific action requested, the number of other users interacting with the 
server, and the speed of your Internet connection are among the factors that determine 
response time. 

• WorldCat interactions. When your request results in a WorldCat interaction, the system 
ignores any repeated requests until you reload the page. This prevents added transaction 
charges and slowed responses that may occur if the system sends repeated commands. Note: 
using the browser’s Stop button while waiting for a WorldCat response may prevent the system 
from reactivating the requested function. 

Unicode fonts recommended 

• For best results when viewing and editing records, and when viewing web-based resources, 
specify a Unicode font in your browser (font settings are found in Options or Preferences). 
Using a Unicode font lets you take full advantage of the system’s adoption of the Unicode 
standard for character encoding. 

• For an extensive set of diacritics and special characters, OCLC recommends that you have the 
Arial Unicode Microsoft font (Arial Unicode MS) installed on your workstation and specified in 
your browser. Microsoft provides the font with many applications, including Microsoft Office, 
FrontPage, and Publisher. 
 
Note: The Arial Unicode MS font is not installed by default with these Microsoft applications. 
For installation instructions, start a Microsoft application such as Word, open Help, and search 
Help for unicode or Arial Unicode MS. 
 

• The Lucida Sans Unicode font, provided with Microsoft Windows XP and Windows Vista, has 
a less-complete character set but may meet your needs. 

• The system currently enables display and editing of the ALA character set for bibliographic and 
authority records. 

• The system uses the UTF-8 character format to communicate with Web browsers and as its 
internal storage format. UTF-8 is a compact encoding of Unicode, a widely adopted standard 
that supports the communication of a large array of characters from the world’s chief languages 
and scripts. 

• More? Search Help for the keyword diacritics or Unicode. 
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Show Connexion icon in Favorites (bookmarks) 

• When you add the URL for the Connexion logon screen to the Favorites (bookmarks) list in your 
browser, the new Favorites item includes a Connexion icon. 

• In Internet Explorer, the Connexion icon may not appear if you previously added the logon 
screen URL to your Favorites or to the browser’s Links bar. 

• To show the icon in the IE Favorites and/or Links bar, follow these steps.  
Note: Display of icons in Firefox bookmarks may work differently. 
 
 Action 
1 In Internet Explorer, delete all existing shortcuts to connexion.oclc.org. This includes 

items in Favorites and items on the Links bar. 
2 Clear the browser cache. 
3 Close all browser windows. 
4 Start Internet Explorer and go to http://connexion.oclc.org. 
5 At the Connexion logon screen, add the URL to the Favorites list. After the item appears 

with the Connexion icon in Favorites, you can copy the item and paste it on the Links bar 
or to the desktop. 
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2. Log on, log off, and set up automatic logon 

URL for access to OCLC Connexion 

Access Type URL 
General Access http://connexion.oclc.org  

 

Log on (start session) 

• Automatic logon. For faster logon, set up a default authorization and password. 
• Cataloging session or Dewey-Only session. 

 
 Action 
1 Point your browser to the appropriate Connexion URL (see table). 

Result 
• Connexion displays the logon screen for a cataloging services session. 

Or 
• If your default authorization is designated Dewey-Only, Connexion displays the 

Dewey Services-only logon screen. 
2 Enter authorization and password: 

• Default authorization and password. Use the displayed authorization. Type the 
password if not already supplied. 

• Multiple saved authorizations. Select a saved authorization from the list. Type 
the password if not already supplied. 

• Type an authorization number and password. 
3 Click Logon or Logon to Dewey-Only Session or press <Enter>. 

 

About the Related Links 

Note: Top link toggle 

• The first link in the Related Links area can be labeled Dewey-Only Session or Cataloging 
Session. When you click the link, the label toggles to show the alternative text. 

• The logon button also toggles when you click the first link. When you click the Dewey-Only 
Session link, the button changes to Logon to Dewey-Only Session. When you click the 
Cataloging Session link, the button changes to Logon. 

• Default setting. Connexion displays a logon screen for a cataloging session: the button label is 
Logon and the first link is Dewey-Only Session. 
 
To display a Dewey-Only logon screen by default, designate your default authorization as 
Dewey-Only. 
 
 
 
 

http://connexion.oclc.org/
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Link Description 
Dewey-Only 
Session 
Shortcut Key 
<Ctrl><Shift><1> 

Top link in the Related Links area of logon screen for a Connexion 
cataloging session. 

• Click to switch to a logon screen for a Dewey Services Only 
session (access only to the Dewey services to which you 
subscribe). 

Authorization. To start a Dewey-Only session, you need one of the 
following: 

• An OCLC Cataloging service authorization that includes a 
subscription to WebDewey and/or Abridged WebDewey. 

• An authorization for Dewey Services only (no access to OCLC 
Cataloging services). 

Why use? Dewey-Only sessions provide access to WebDewey and/or 
Abridged WebDewey and 

• Do not incur access and user support fees 
• Do not count against simultaneous logon limits for libraries 

subscribing to flat fee Internet access 
• Include a default inactivity timeout of 120 minutes (default timeout 

for other Connexion sessions is 40 minutes) 
Cataloging 
Session 
Shortcut Key 
<Ctrl><Shift><1> 

Top link in Related Links area of logon screen for a Dewey-Only session. 
• Click to switch to a logon screen for a Connexion cataloging 

session (access to all Connexion services for which you are 
authorized). 

Authorization. To start a cataloging session, you need an OCLC 
cataloging services authorization number and password. 

Connexion 
Documentation 
Shortcut Key 
<Ctrl><Shift><2> 

Link to a page on the OCLC web site that lists all Connexion-specific 
documentation and related resources. 

Connexion 
Tutorials 
Shortcut Key 
<Ctrl><Shift><3> 

Link to a page on the OCLC web site that lists Connexion online tutorials. 
Tutorials available: 

• Using Connexion, An OCLC Tutorial. Covers essential cataloging 
functionality in the Connexion browser interface, including 
retrieving, editing, and taking final actions on bibliographic records. 

• CatExpress tutorial 
• WebDewey tutorial 

OCLC 
Cataloging Label 
Program 
Shortcut Key 
<Ctrl><Shift><4> 

Link to the product page for the OCLC Cataloging Label Program. 
From this page, you can 

• Download the Label Program software. 
• View the TourGuide (brief online tutorial) for the label program. 
• View or download documentation. 
• Find other resources to help you use the product effectively. 

 
 
 
 
 
 



Requirements, Access, Interface Map   
 

 
 

 20160229 
 

 

16 

Link Description 
OCLC Usage 
Statistics 
Shortcut Key 
<Ctrl><Shift><6> 

Link to OCLC Usage Statistics. 
• Click to log on automatically to the Usage Statistics server using 

the authorization and password currently visible on the logon 
screen. 

• The link takes you directly to a screen listing the Connexion 
statistics available for your institution. 

For more information on the available reports and instructions for viewing 
reports, click Help on the Usage Statistics screen. 

System Alerts 
Shortcut Key 
<Ctrl><Shift><7> 

Link to the OCLC System Alerts page. 
If you have difficulties while logging on to Connexion or while using the 
system, check this page for information on any known system problems. 

 

Set up automatic logon (Local Browser Settings) 

• You can save your Connexion authorization number and password to avoid retyping this 
information each time you log on. 

• You can save up to ten authorizations and passwords then select the authorization to use when 
logging on. If desired, you can set your most-used authorization as the default. 

• You can assign a name (up to 8 characters) to each authorization/password pair to specify a 
purpose, type (Limited, Full, etc.), project, user’s name, or other identifier. 

• For each entry, you can save authorization number only or authorization and password. You 
can designate a saved authorization as Dewey Services only. 

• The logon information you supply is saved by your browser as a cookie. The cookie, a small text 
file, resides on your workstation, in your browser’s cookies folder. If you use multiple browsers 
to access Connexion (for example, if you use both Internet Explorer and Firefox), you must save 
Local Browser Settings in each browser. 

• As a security measure, the system encrypts your authorization and password both when storing 
them on your workstation and when sending them to the Connexion browser. 

• To save your authorization and/or password, you must enable cookies in your browser. 
 
Use Local Browser Settings 
To do this Procedure 
Save a default 
authorization 

1. Type an authorization number (required). 
2. Type a password (optional). If you prefer to enter the password each 

time you log on, leave the Password box empty. 
3. In the Name box, type an identifier (up to 8 characters) for the 

authorization/password combination (optional). 
4. In the Dewey-Only box, type Y or N (required). 
5. Set as default authorization. Click to select the Default option 

button for the authorization you entered. Or select No Default 
Authorization. 

6. When finished, click Save Settings. Then click OK. 
Save multiple 
authorizations 

1. For each entry, 
─ Type an authorization number (required). 
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─ Type a password (optional). If you prefer to enter the password 
each time you log on, leave the Password box empty. 
─ In the Name box, type an identifier (up to 8 characters) for the 
authorization/password combination (optional). 
─ In the Dewey-Only box, type Y or N (required). 

2. Repeat step 1 to add another entry. 
3. Set a default authorization (optional). Click to select the Default 

option button for the authorization you want to use. Or select No 
Default Authorization. 

4. When finished, click Save Settings. Then click OK. 
View list of saved 
authorizations 
and names 

1. On the login screen, open the Choices list and click the last item, 
More Details. 

2. In the Authorization List window, click an authorization number to 
select it. Or click Close Window to return to the login screen. 

Results 
• When you click an authorization number, the Authorization List     
     window closes and the selected authorization appears on the login   
     screen, ready for use. 

 
No default 
authorization 

1. Click to select the option button for No Default Authorization. 
2. (Optional) Default Dewey-Only logon. To set the Dewey-Only 

Session logon screen as the default, change the Dewey-Only setting 
to Y. 

3. Click Save Settings. Then click OK. 
Save new or 
changed settings 

• Click Save Settings. 
Results 
• The system displays a confirmation message. 
• When you click OK, the Local Browser Settings window closes. 

To do this Procedure 
Undo changes, 
restore previously 
saved settings 

• Click Reset. 
Results 
• The system cancels any changes you made since you opened the 

Local Browser Settings window. 
• Settings previously saved (if any) appear on the screen. Or the 

system restores the original system defaults (all text removed no 
default authorization). 

Restore system 
defaults (delete 
all entries) 

1. Click System Defaults. 
2. Click OK to confirm that you want to erase all saved 

authorizations/passwords and set Dewey-Only options to No. 
Results 
• Authorization numbers, passwords, and Dewey-Only settings are 

removed. 
• No Default Authorization is selected, with Dewey-Only set to No. 

 

Why use a Dewey-Only session? 

Benefits for OCLC cataloging users: 
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• Session does not incur access and user support fees. 
• Session does not count against simultaneous logon limits for libraries subscribing to Flat Fee 

Internet access. 
• Dewey-only sessions have a default inactivity timeout of 120 minutes (default timeout for other 

Connexion sessions is 40 minutes). 
• You can start a Dewey-only session from within a Connexion cataloging session via automatic 

logon. 
• You can start a cataloging session via automatic logon from within a Dewey-only session. 
• You can have both a cataloging session and a Dewey-only session open at once and switch 

between them while working. You are charged access and user support fees for the cataloging 
session as long as that session remains open. 

Benefits for Dewey Services subscribers: 

• The 120-minute inactivity timeout lets you remain logged on to WebDewey and/or Abridged 
WebDewey while you switch to another application to complete other cataloging tasks. Your 
Dewey Services session stays active, ready for use when you need it. 

 

 

 

 

 

Start cataloging session or Dewey-Only session 

Start Dewey-only session 

Start session Procedure 
Default Dewey-
Only session 

If you designate your default authorization as Dewey-Only (in Local Browser 
Settings), the system automatically displays the Dewey-only logon screen. 
1. Enter authorization and password: 

─ Default authorization and password. Use the displayed authorization.   
Type the password if not already supplied. 

─ Multiple saved authorizations. Select a saved authorization from the list. 
Type the password if not already supplied. 

─ Or type an authorization number and password. 
2. Click Logon to Dewey-Only Session or press <Enter>. 
Result 
• The system starts a Dewey-Only session and displays the Connexion home  
     screen. 

From Connexion 
cataloging logon 
screen 

1. Under Related Links, click Dewey-Only Session. 
2. Enter authorization and password: 

─ Default authorization and password. Use the displayed authorization.   
Type the password if not already supplied. 
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─ Multiple saved authorizations. Select a saved authorization from the list. 
Type the password if not already supplied. 

─ Or type an authorization number and password. 
3. Click Logon to Dewey-Only Session or press <Enter>. 
Result 
• The system starts a Dewey-Only session and displays the Connexion home  

     screen. 
From Connexion 
cataloging 
session 
Shortcut Key 
<Alt><N> 

• On the Dewey Services tab, under Show Options, click Start Dewey-Only.    
      Or press <Alt><N>. 
Result 

 The system 
• Opens a new browser window for the Dewey-Only session. 
• Logs you on automatically to the new session. 
• Selects the Dewey Services tab and displays the screen you specified as the   

Dewey Session Start Page (on the Dewey Services Options screen, under  
New Session Options). 

Specify starting screen for Dewey-Only session 
• On the Dewey Services Options screen, under New Session Options, use the  

list labeled Dewey-Only Session Start Page to select the screen you want  
displayed immediately after you start a new Dewey-only session from a  
cataloging session. 

Default setting: Search WebDewey (or Search Abridged WebDewey). 
Choices (available options determined by your subscription): Search 
WebDewey, Browse WebDewey, Search Abridged WebDewey, and Browse 
Abridged WebDewey. 

 

 

Start cataloging session 

Start session Procedure 
Default 
cataloging 
session 

Unless you designate your default authorization as Dewey-Only (in Local 
Browser Settings), the system automatically displays the logon screen for a 
cataloging session. 
1. Enter authorization and password: 

─ Default authorization and password. Use the displayed authorization.   
Type the password if not already supplied. 

─ Multiple saved authorizations. Select a saved authorization from the list. 
Type the password if not already supplied. 

─ Or type an authorization number and password. 
2. Click Logon or press <Enter>. 
Result 
• The system starts a cataloging session and displays the Connexion home  

screen. 
From Dewey-
Only logon 
screen 

1. Under Related Links, click Cataloging Session. 
2. Enter authorization and password: 

─ Default authorization and password. Use the displayed authorization.   
Type the password if not already supplied. 
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─ Multiple saved authorizations. Select a saved authorization from the list. 
Type the password if not already supplied. 

─ Or type an authorization number and password. 
3. Click Logon or press <Enter>. 
Result 
• The system starts a cataloging session and displays the Connexion home  

screen. 
From Dewey-
Only session 
Shortcut Key 
<Alt><N> 

• On the Dewey Services tab, under Show Options, click Start Cataloging.    
      Or press <Alt><N>. 
Result 

 The system 
• Opens a new browser window for the Cataloging session. 
• Logs you on automatically to the new session. 
• Selects the Cataloging tab and displays the screen you specified as the   

Cataloging Session Start Page (on the Dewey Services Options screen, under  
New Session Options). 

Specify starting screen for Cataloging session 
• On the Dewey Services Options screen, under New Session Options, use the  

list labeled Cataloging Session Start Page to select the screen you want  
displayed immediately after you start a new Dewey-only session from a  
cataloging session. 

Default setting: Search WorldCat. 
Choices (available options determined by your subscription): Search 
WorldCat, Browse WorldCat, Search Authorities, and Browse Authorities. 

 

 

 

Switch between active sessions: tips 

• Switch sessions via the taskbar. When you have both a cataloging session and a Dewey-only 
session open, you can use the Windows taskbar to switch between the sessions. To switch, 

─ Click the browser icon for the session you want to use. 
─ Or press <Alt><Esc> to move through all running programs to reach the window for the 

session you want. 
─ Or press <Alt><Tab> to select the correct browser icon from a list of icons for all running 

programs. 
• Shortcut to start new session. The keyboard shortcut <Alt><N> automatically opens a new 

session. 
─ In a Dewey-Only Session, pressing <Alt><N> opens a cataloging session. 
─ In a cataloging session, pressing <Alt><N> opens a Dewey-Only session. 

• Which session is this? 
─ In a Dewey-Only session, only the Dewey Services tab and the General tab are 

present. 
─ In a cataloging session, the Cataloging and/or Authorities tab(s) are present; tabs for 

other Connexion services may also appear, depending on your authorization and your 
customization of the interface. 
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Log off (end session) 

 Action 
1 At the right end of the header bar at the top of the screen, click Logoff or press <Alt><L>. 

If no records remain in edit mode, the system ends your session and displays the logoff 
screen. 
The logoff screen lists the time you logged on, the time you logged off, and the duration 
of your session. At the bottom of the logoff screen is a link to the logon screen, so that you 
can log on again conveniently. 

2 If any records remain in edit mode, the system notifies you that you will lose your edits 
unless you save the records or complete the records (add them to, or replace them in, 
the appropriate database) before logging off. You can 
• Log off and discard unsaved edits. On the message screen, click Logoff Anyway. 
Or 
• Complete edits and save, add, or replace record(s). On the message screen, click  

Show Active Records. At the Active Records screen, find the section for the service 
and/or database you were using. To view a record, click the hyperlinked title of the 
record you want. 

• When finished completing or saving records, on the header bar click Logoff or press  
<Alt><L>. 

Note: Turn off logoff warning for active records 
If you prefer not to be notified about active records before logging off, use the Show or 
Hide Logoff Warning option to prevent the system from displaying the warning. 
1. On the General tab, click Admin. On the Preferences screen, click General Options. 

Then click Interface Customization Options. 
2. On the Interface Customization Options screen, find the Show or Hide Logoff 

Warning option and select Hide. 
 

End session via automatic logoff 

• With automatic logoff turned on (the default setting), you can also end a session by closing 
your browser. 

No automatic logoff (not recommended) 

• If you turn off the automatic logoff function, closing the browser does not end a session. The 
session remains active until the Connexion server ends it after 40 minutes of inactivity. 

• Note: Setting a shorter inactivity timeout period via the Session Timer option does not work to 
end a session after you close the browser. The browser, not the Connexion server, monitors 
inactivity intervals less than 40 minutes. 

• When a session remains open, the system treats that session as a regular user session. The 
open session counts against simultaneous logon limits for libraries that subscribe to Flat Fee 
Internet access. You (or others from your institution) may be unable to log in again until an 
inactivity timeout ends the “lost” session. 

• OCLC User & Network Support staff can end the active session. 
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About the session timer and inactivity timeout 

Inactivity timeout 

• The inactivity timer ends a session automatically after a period of no interaction with the server. 
─ For cataloging sessions, 40 minutes of inactivity is the default setting. 
─ For Dewey Services-only sessions, the default inactivity timeout is 120 minutes. 

• For cataloging sessions, you can specify automatic logoff after as little as 10 minutes of 
inactivity. This setting uses a timer monitored by the browser. If you close the browser without 
logging off, the 40-minute inactivity period monitored by the server is in effect. However, the 
automatic logoff function (on by default) ends the session when the browser closes. 

Note: Not for Dewey-only sessions. The option to shorten the inactivity timeout is not 
available for Dewey Services-only sessions. It is not needed because Dewey-only sessions do 
not incur access or user support fees or count against simultaneous-session limits. 

• The inactivity timer prevents a session from remaining open indefinitely (and incurring access 
and user support fees) after a user stops working but neither logs off nor closes the browser. 
Specifying a shorter inactivity timeout further reduces the potential for problems caused by 
unused sessions. 

Why unexpected timeouts can occur 

• The system cannot recognize activity that does not involve interaction with the server. 
• When you edit or type in a text box, for example, you are working locally: changes occur on the 

displayed screen, but you do not interact with the server. The system does not recognize these 
changes as activity until you take an action that involves the server; for example: starting a 
search or browse, selecting a record from search results, saving a user note, etc. 

• If you spend more than 40 minutes working locally without taking an action that requires 
interacting with the server, the inactivity timer may log you off. 

Prevent unexpected timeouts 

• Timer display. Check the time remaining before a timeout on the digital timer display. You can 
locate the countdown timer on the header bar or on the status bar. The display shows the 
number of minutes and seconds remaining before an inactivity timeout will occur. For cataloging 
sessions, the timer counts down from 40 minutes (or an interval of 10 to 40 minutes you specify) 
until you interact with the server (120 minutes for Dewey-only sessions). After each interaction, 
the timer resets and counts down again until the next interaction. 

• Timeout warning. The system automatically warns you 5 minutes before a session is about to 
expire due to inactivity. You can specify that the warning appear from 1 minute to 9 minutes 
before the session will expire. And you can have the message appear in a pop-up box (instead 
of in the menu area or the Connexion screen) to make it more noticeable. 

• More frequent interaction. While working, periodically take an action such as switching 
screens, moving between records and results list, etc. Make a habit of interacting every few 
minutes, just as you make a habit of saving your work often while using a desktop computer. 
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3. Accessibility features 

Accessibility features (Connexion browser) 

• Accessibility features make it easier for users with disabilities to use Connexion browser 
effectively. The Connexion browser interface is compliant with most of the United States Section 
508 requirements. Blind users, or users with limited vision, may use a screen reader to read the 
text and properly marked-up images on the page. Users with limited manual dexterity or limited 
eye-hand coordination can use the keyboard to access functionality usually accessed with a 
mouse. 

• Accessibility features can also provide additional capabilities for all users, provided that their 
browsers support those features. All versions of Internet Explorer, Firefox and other browsers 
that are officially supported by Connexion can provide the features listed in this topic. Note that 
internal errors (“bugs”) in the browser can sometimes prevent features from working as 
expected. 

List of accessibility features 

• Keyboard shortcuts. Keyboard shortcuts allow you to click a button or link, or select from a 
list, by combining the <Alt> key (or <Ctrl> or <Ctrl><Shift> keys) with another key. Once you 
log on to Connexion browser, you can view a list of all keystroke shortcuts by pressing 
<Shift><F7>. To print the list of shortcuts, click the Print button at the top of the list window. 

• Hover text for images, form elements, and some links. All graphical buttons and icons that 
convey information have associated text that appears when you hover the cursor over them. 
The HTML coding for image text uses both the ALT attribute and the TITLE attribute for 
maximum compatibility with screen readers. Buttons that are generated by JavaScript without 
images do not have mouseover text because screen readers can access the button text 
directly. 

• Tables. Most tables use the TH (table heading) tag for row and column headings and the TD 
(table data) tag for data. Some screen readers use this information to associate row and column 
headings with individual cells. 

• Skip navigation. The cursor is automatically positioned to the first input field below the 
repetitive navigation links that appear on every screen. In addition, a keyboard shortcut is 
provided that skips the repetitive links and positions to the end of the repetitive navigation 
area. 

• Resizable text. All text outside of images in Connexion browser is resizable in the browser, 
so users with limited vision can request larger text if desired. 

• Other features. The administrative area provides several accessibility options on the Interface 
Customization Options screen. (To access these settings, on the General tab, click the Admin 
button, select General Options, and then click Interface Customization.) These options 
include: 

─ Optimize Images allows use of images instead of text for the tabs and oval action 
buttons in the upper navigation area, as well as in many (but not all) other lower areas 
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of the application. 

─ Show or Hide Go Button places a Go button in the navigation area so that 
JavaScript will not automatically activate a choise highlighted on one of the navigation 
lists (Search, Browse, Create, and Show). This option does not yet apply to areas 
other than the navigation bar, but the keystroke <Alt><DownArrow> can be used in 
supported browsers to make a selection from those lists (such as the Edit, Action, and 
View lists on record screens) more accessible. 

─ Session Timer Options provides options that allow a visible warning which can be 
detected by screen readers when your session is ready to expire, and a button that 
can be used to extend the session. 

─ Size of Tab Images and Text in Navigation Bar provides a much larger set of 
navigation tabs and buttons for those who have chosen to resize text significantly. 
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4. Active Records screen

Why use the Active Records screen? 

• Resume editing a record after interrupting your work.
• Switch between multiple active records.
• If Connexion warns you at logoff that you have unsaved, edited records, review your active

records and decide whether to save or complete them before logging off.

Record list 

• The Active Records screen lists records currently in edit mode, in any database to which you 
have access.

• Records are listed under headings that indicate the record type or the database from which 
you retrieved the record.

• Headings appear only for categories in which you have active records.
• Within each category, the last-opened records appears at the top of the list. The record 

opened first appears at the bottom.
• For bibliographic and authority records, the list includes both locked WorldCat records and 

copies of records you are editing for local use.
• The Active Records screen also lists new records or constant data records you have not yet 

saved or added to a database.
• The CatExpress service does not use the Active Records screen.

Go to Active Records screen 

Action 
Keystroke shortcut 
• On any screen, press <Ctrl><Shift><9>.

Navigation bar button or keystroke
• On any tab, click Show or press <Alt><4>.

View listed record
• On the Active Records screen, the record most recently opened in edit mode, within

the top category on the screen, is highlighted.
• To view the highlighted record, press <Enter>.
• Press <Tab> or <Shift><Tab> to move to other records in the list. Note: Highlighting

disappears when you press <Tab> or <Shift><Tab> to select another listed record.
Note: The Active Records screen is not available from the Express tab (CatExpress 
service) or the General tab. 



Requirements, Access, Interface Map 

 

20160229 

26 

Active Records categories 

Category Description 
Bibliographic Records 
Note: Active local 
holdings records linked 
to a bibliographic record 
are listed under the master 
bibliographic record to 
which they are attached. 

 The Bibliographic Records category lists records retrieved from 
WorldCat and newly created records (workforms).

 The link for each active record includes the OCLC control 
number and the title or (if the record contains no title) No Title 
Provided.

 For a locked WorldCat record, the link includes the label 
(Locked).

 For new records (not yet saved or added to WorldCat), the link 
shows only the title or No Title Provided.

 The link to an active local holdings record (LHR) or LHR 
workform appears under the link to the bibliographic record to 
which the LHR is attached. The link on the Active Records 
screen shows the OCLC symbol of the institution that owns the 
LHR, and the location (holding library code) associated with the 
LHR.

Bibliographic Save File  The Bibliographic Save File category lists records
retrieved from the save file.

 The link for each active record includes the save file number and the 
title or (if the record contains no title) No Title Provided.

 For a locked WorldCat record, the link includes the label (Locked).
Bibliographic Constant 
Data 

 The Bibliographic Constant Data category lists records
retrieved from the constant data database and newly created
constant data records.

 The link for an active constant data record shows the constant data
name.

 For a newly created CD record, the link text is New.
Local Holdings Constant 
Data 

 The Local Holdings Constant Data category lists records
retrieved from the LH constant data database and newly created
LH constant data records.

 The link for an active LH constant data record shows the constant
data name.

 For a newly created LH CD record, the link text is New.
Authority Records  The Authority Records category lists records retrieved from

the Connexion Authority file and newly created authority
records (workforms).

 The link for each active record includes the ARN and the main 
entry or (if the record contains no main entry) No Main Entry 
Provided.

 For a locked WorldCat record, the link includes the label 
(Locked).

 For a new authority record (not yet saved or added to the 
Authority File), the link shows only the main entry or No Main 
Entry Provided.
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Category Description 
Authority Save File  The Authority Save File category lists records retrieved from the save file.

 The link for each active record includes the save file number and the main 
entry or (if the record contains no main entry) No Main Entry Provided.

 For a locked WorldCat record, the link includes the label (Locked).

Authority Constant Data  The Authority Constant Data category lists records retrieved
from the constant data database and newly created constant
data records.

 The link for an active constant data record shows the constant data
name.

 For a newly created CD record, the link text is New.
WebDewey User Notes or 
Abridged WebDewey User 
Notes 

The User Notes categories show the following types of hyperlinks for 
active user notes: 
 Notes are identified by title.
 Note workforms not yet saved are also identified by title.
 For a Note workform without a title, the hyperlink text is No Title

Provided.
Digital Archive Records  The Digital Archive Records category lists records retrieved from

the Digital Archive and newly created records.
 The link for each active record includes the control number

(assigned when the record was added to the DA database) and the
title or (if the record contains no title) No Title Provided.

 For a new record (not yet saved or added to the Digital Archive), the
link shows only the title or No Title Provided.

Digital Archive Save File  The Digital Archive Save File category lists records retrieved from
the save file.

 The link for each active record includes the save file number and the
title or (if the record contains no title) No Title Provided.

Digital Archive Constant 
Data 

 The Digital Archive Constant Data category lists records retrieved
from the constant data database and newly created constant data
records.

 The link for an active constant data record shows the constant data
name.

 For a newly created CD record, the link text is New.

Record used to create a new record not on Active Records screen 

• When you create a new bibliographic record or authority record (using the Derive New Record
action), the base record (the record you derived from) is no longer listed on the Active Records
screen.

• The link for the new record contains the title or main entry only (not a record number or save file
number).



Requirements, Access, Interface Map   
 

 
 

 20160229 
 

 

28 

5. System home page and navigation bar 

About the home page 

The home page is the first screen you see after you log on to OCLC Connexion. 

To return to the home page at any time, click Home on the header bar at the top of the screen.  

Use the home page to 

• View the OCLC Cataloging Message of the Day. 
• Find links to documentation, news, and instructions. 

Message of the Day 

The OCLC Cataloging Message of the Day appears in the center of the home page. 

View OCLC system news 

The News area provides access to current information of interest to OCLC users. News topics include: 

• General OCLC announcements 
• News about specific products and services 
• Release notes describing recent system updates 
• Information on planned system enhancements 

Access OCLC system news 

Action  Result 
On the General tab, click News. 
Or 
On the home page, in the gray column 
on the right, under Topics, click News. 

The Search News screen appears. 
To find items of interest, you can 
 Retrieve all current News items. 
 Retrieve News by category. 
 Search for words in the titles of 

News items. 
 Search for words in the contents 

of News items. 
 

Topics and Useful Links 

The gray column on the right provides quick access to information and tools for Connexion users: 

• Search screen for searching OCLC System News. 
• Documentation for OCLC Connexion. 
• Product information on OCLC Connexion and related cataloging services. 
• WorldCat statistics page on the OCLC web site. 
• The OCLC System Alerts page. If you have difficulties while using the system, check this page 

for information on any known system problems. 
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• Web-based forms for requesting changes to WorldCat records or Authority File records, and for 
requesting a merge of duplicate records. 

• OCLC Usage Statistics, a web application that lets you view statistics on cataloging activity for 
your institution or for your authorization. 

• Legal information such as software license terms and copyright statements. 
• Information to help you identify and resolve problems with Connexion browser. The Known 

problems and troubleshooting link displays a page on the OCLC web site that lists known 
problems and provides a troubleshooting checklist. 

Navigation Bar 

• Appears at the top of all screens. 
• Contains a set of tabs, one tab for each service available to you. Your authorization and/or 

subscriptions to specific services determine which service tabs appear. 
• On each service tab, provides buttons labeled Search, Browse, Create, and Show. Click a 

button for access to a frequently used function. 
• On each service tab, provides lists labeled Search Options, Browse Options, Create Options, 

and Show Options. Open an Options list to select a specific function. 
• Includes a General tab that lets you set preferences to customize the navigation bar, assign 

shortcut keys to frequently used actions, set service-specific options, access OCLC System 
News, and view web-based documentation for OCLC Connexion. 

• Lets you navigate by clicking a tab, a button, or an item on an Options list. 
• Supports keyboard-only navigation if you prefer to avoid using a mouse. 
• Can be customized to meet your needs. For example, you can hide tabs for services you 

rarely use, add a horizontal scroll bar, enlarge the tabs and text, or facilitate keyboard-only 
access to the Options lists. 

• The header bar is the black bar at the top of each screen, above the navigation bar. 
• Via links on the header bar, you can access the functions listed in the following table. 

Header link Use it to 
Home Return to the system home page. 
Help Get context-specific help for the current screen. From the Help window, you 

can search Help for additional information. 
Diacritics View a table of diacritics and special characters. Use the table to identify a 

character, find a character by name, or copy a character for input in a record. 
Contact Send a problem or question via email to your regional network, service center, 

or OCLC User Network Support.  
Send a suggested change or enhancement via email to the OCLC product 
specialists. 

Logoff Log off the system and return to the login page. 
 

Navigation keys 

• You can use tabs, buttons, and Options lists on the navigation via keyboard only. 
• The keystrokes work in all supported versions of Internet Explorer. 



Requirements, Access, Interface Map   
 

 
 

 20160229 
 

 

30 

• Sometimes a keystroke does not work because the navigation bar is not the active frame 
(screen area). If a keystroke should work but does not, click once on the navigation bar to make 
it the active frame. (Click the open area at the right end of the navigation bar.) Then repeat the 
keystroke. 

Purpose Keystroke 
Header bar -- select an action 
Home <Alt><O> 
Help <Alt><H> 
Contact (Support) <Alt><S> 
Diacritics <Alt><,> (comma) 
Logoff <Alt><L> 
Tabs -- select a tab (if it is visible on screen) 
Cataloging <Alt><C> 
Authorities  <Alt><A> 
Express <Alt><E> 
Dewey Services <Alt><D> 
Digital Archive <Alt><I> 
General  <Alt><G> 
More <Alt><M> 
Buttons -- select a button (on active tab) 
Search  
Or 
News on General tab 

<Alt><1> 

Browse 
Or 
Admin on General tab 

<Alt><2> 

Create 
Or 
Documentation on General tab 

<Alt><3> 

Show <Alt><4> 
Options lists -- select list (on active tab) 
Go button off. If you did not add a Go button to the navigation bar,  
 Press the shortcut key for the Options list. 
 Then press <down-arrow> once to select first item on the list. 

Go button on. If you added a Go button to the navigation bar, 
 Press the shortcut key for the Options list. 
 Then press <down-arrow> to select an option. 
 Then press <Enter> to take action (if you have not moved the cursor 

from the Options list). 
Or press <Alt><8> to take action (if you moved the cursor to a position in 
the lower frame of the screen). 
Search Options <Alt><!> 
Browse Options 
Or 
Admin Options on General tab 

<Alt><@> 
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Purpose Keystroke 
Create Options <Alt><#> 
Show Options <Alt><$> 
Other Options 
Express tab only 

 

Bypass navigation bar 
Note: This function is included to facilitate use of screen-reading software. 
Skip links on header bar and tabs; 
move to end of navigation bar. 
Press <Tab> to move to first field or 
list on current screen. 

<Ctrl><K> 
Or 
<Alt><F9> 

Switch between navigation bar and main frame (record or dialog box) 
Move from navigation bar to record/ 
dialog frame 
Or 
Move to navigation bar from record/ 
dialog frame 

<Ctrl><Shift><Tab>  
(Internet Explorer) 

 

Keystrokes for search and browse screens 

Note: You cannot customize these keystrokes. 

To go to this screen Press these keys 
Search WorldCat <Ctrl><Shift><W> 
Search Bibliographic Save File <Ctrl><Shift><T> 
Search Authority File <Ctrl><Shift><J> 
Search Authority Save File <Ctrl><Shift><O> 
Browse WorldCat (Title Phrase or 
Scan Title search) 

<Ctrl><Shift><B> 

Browse Authority File  <Ctrl><J> 
View WorldCat Search History <Alt><=> (Alt + equal sign) 
WorldCat Group Results <Ctrl><0> 
WorldCat Search Results <Ctrl><1> 
Bibliographic Save File Search Results <Ctrl><3> 
Bibliographic Constant Data Search 
Results 

<Ctrl><4> 

WorldCat Browse Results <Ctrl><6> 
Bibliographic Review File Search 
Results 

<Ctrl><7> 

Local Holdings Group Summary <Ctrl><8> 
Local Holdings Institution Summary <Ctrl><9> 
Search WorldCat <Ctrl><Shift><W> 
Search Bibliographic Save File <Ctrl><Shift><T> 
Search Authority File <Ctrl><Shift><J> 
Search Authority Save File <Ctrl><Shift><O> 
Browse WorldCat (Title Phrase or 
Scan Title search) 

<Ctrl><Shift><B> 
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To go to this screen Press these keys 
Browse Authority File  <Ctrl><J> 
View WorldCat Search History <Alt><=> (Alt + equal sign) 
WorldCat Group Results <Ctrl><0> 
WorldCat Search Results <Ctrl><1> 
Bibliographic Save File Search Results <Ctrl><3> 
Bibliographic Constant Data Search 
Results 

<Ctrl><4> 

WorldCat Browse Results <Ctrl><6> 
Bibliographic Review File Search 
Results 

<Ctrl><7> 

Local Holdings Group Summary <Ctrl><8> 
Local Holdings Institution Summary <Ctrl><9> 
Local Holdings Constant Data Search 
Results 

<Ctrl><-> (hyphen) 

Authority File Search Results <Ctrl><Shift><0> 
Authority Save File Search Results <Ctrl><Shift><1> 
Authority Constant Data Search 
Results 

<Ctrl><Shift><3> 

Authority File Browse Results <Ctrl><Shift><4> 
Authority Review File Search Results <Ctrl><Shift><7> 
Show Active Records <Ctrl><Shift><9> 
Search Dewey User Notes <Ctrl><Shift><[> (left square bracket) 
Search Abridged Dewey User Notes <Ctrl><Shift><]> (right square bracket) 
Show/Hide WorldCat Quick Search 
(Record Views and Search Results) 

<Alt><Q> 

Move to WorldCat Quick Search 
(Record Views and Search Results) 

<Alt><.> (Alt + period) 

Show/Hide Record Viewing Buttons 
(Search results for specific databases 
only) 

<Alt><Y> 

 

New session (Dewey-only or cataloging) 

• To use both a cataloging session and a Dewey-Only session, you need an OCLC cataloging 
authorization and a subscription to WebDewey or Abridged WebDewey. 

• Note: You cannot customize this keystroke. 

To Press these keys 
Start a new Dewey-Only session from 
a cataloging session 

<Alt><N> 

Start new cataloging session from a 
Dewey-Only session 

<Alt><N> 
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Special purpose keystrokes 

Note: You cannot customize these keystrokes. 

To  Press these keys 
Enter diacritics or special characters 
using a popup character chart window 

<F7> 

List all keystrokes <Shift><F7> 
Enter MARC subfield delimited ($) <F8> 
Print bibliographic or authority record <F12> 
Download Export Files screen <Ctrl><[> (left square bracket) 
Download Label Files screen <Ctrl><]> (right square bracket) 
Show Command Lists (Edit, Action, 
and View lists) 

<Alt><J> 

Show Command Shortcuts 
(alphabetical list of available 
commands and shortcuts, above 
record view) 

<Alt><K> 

Show or hide Dewey Services work 
area 

<Alt><W> 

Move cursor to Dewey Services work 
area 

<Alt><.> (period) 

Open Dewey work area dialog box <Alt><Shift><.> (period) 
Show Dewey Tables 
(Dewey Services tab only) 

<Ctrl><[> (left square bracket) 

Show Abridged Dewey Tables 
(Dewey Services tab only) 

<Ctrl><]> (right square bracket) 

Search OPAC for Dewey Number 
(Dewey Services tab only) 

<Alt></> (slash) 

Move between first fixed-field element 
and first variable field (bibliographic 
and authority records) 

<Alt></> (slash> 

Move to the top or bottom of the record 
screen 

<Ctrl><Home> to move to the first 
input box on the screen 
<Ctrl><End> to move to the last input 
box on the screen 

Show or hide the Functions list 
(bibliographic or authority records in 
template editing views) 

<Alt><Y> 

Go to the Active Records screen <Ctrl><Shift><9> 
 

View and print list of keystrokes 

• Shortcut to view printable keystroke list. Press <Shift><F7> to view and print the list of 
keystrokes assigned to actions, navigation keystrokes, and special-purpose keystrokes from 
any Connexion screen. 
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 Action 
1  On the Keystroke Shortcut Options screen, click Print. 

Or 
 From any Connexion screen, press <Shift><F7>. 

The Keystroke Shortcuts List window opens. 
2 In the Keystroke Shortcuts List window, 

 Click Print or press <Ctrl><P>. 
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6. Overview of services and actions 

About the overview table 

Notes: 

• The General tab provides access to OCLC System News, user and sesion information, service-
specific preferences (for services available to you), and interface customization options, 
regardless of the services available. 

• The following table does not describe the Selection tabs. Your library must be profiled to use 
Selection. 

• The table lists services available to OCLC member libraries. 

Cataloging tab 

Service 
Tab 

Button or Menu Item Result and Definition 

Cataloging Search button Search WorldCat 
Search Options 
WorldCat 
Save File 
Bib Constant Data 
LH Constant Data 

Search WorldCat, the bibliographic save file, or your 
institution’s constant data (bibliographic or local holdings CD 
records). 

 Browse button Browse WorldCat (title phrase search) 
Browse Options Browse WorldCat (title phrase search) 

 Create button Create a new bibliographic record by automatically extracting 
data from a web site or by selecting a workform. 

Create Options 
 
Single Record 
 
 
Multiple Records 
 
 
Import Records 
 
 
 
Bib Constant Data 
 
 
LH Constant Data 

 
 
Create a new bibliographic record by automatically extracting 
data from a web site or by selecting a workform. 
 
Extract links from an HTML page and create initial 
bibliographic records. 
 
Import MARC bibliographic records exported from WorldCat, 
provided by OCLC offline services, or created in another 
system. 
 
Use MARC or Dublin Core format to create a constant data 
record that contains frequently used bibliographic information. 
 
Create a constant data record that contains frequently used 
local holdings information. 

Show button List records flagged in the bibliographic save file. 
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Service 
Tab 

Button or Menu Item Result and Definition 

 Show Options 
 
Active Records 
 
By Status 
 
Flagged SF Records 
 
Flagged CD Records 
 
 
Flagged LH CD 
Records 
 
Default Bib CD 
 
Default LH CD 

 
 
List bibliographic records currently open or being edited. 
 
Lists records (by status) in the bibliographic save file. 
 
List records flagged in the bibliographic save file. 
 
List records flagged in your library’s bibliographic constant 
data database. 
 
List records flagged in your library’s local holdings constant 
data database. 
 
View and/or edit your default bibliographic constant data. 
 
View and/or edit your default local holdings constant data. 

 

Authorities tab 

Service 
Tab 

Button or Menu Item Result and Definition 

Authorities Search button Search the Connexion Authority File to find LC/NACO name 
or subject authority records. 

Search Options 
 
Authority File 
 
 
Save File 
 
Authority History 
 
 
Constant Data 

 
 
Search the Connexion Authority File to find LC/NACO name 
or subject authority records. 
 
Search the authority save file. 
 
Retrieve all versions of an authority heading by searching a 
database of superseded authority records 
 
Search your institution’s authority constant data. 

 Browse button Browse the Connexion Authority File to find LC/NACO name 
or subject authority records. 

Browse Options 
 
Authority File 
 
 
Authority History 

 
 
Browse the Connexion Authority File to find LC/NACO name 
or subject authority records. 
 
Retrieve all versions of an authority heading by browsing a 
database of superseded authority records. 
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Service 
Tab 

Button or Menu Item Result and Definition 

 Create button Search the Connexion Authority File to find LC/NACO name 
or subject authority records. 

Create Options 
 
Authorities 
 
Import Records 
 
 
Constant Data 
 

 
 
Create a new authority record by completing a workform. 
 
Import MARC authority records exported from the Authority 
File or created in another system. 
 
Use MARC format to create a constant data record that 
contains frequently used information. 

 Show button Lists authority records (by status) in the Connexion Authority 
save file. 

Show Options 
 
Active Records 
 
By Status 
 
 
Flagged AF Records 
 
Flagged SF Records 
 
 
Default CD 
 
Responded File 

 
 
List authority records currently open or being edited. 
 
Lists authority records (by status) in the Connexion Authority 
save file. 
 
List authority records flagged in the Connexion Authority File. 
 
List authority records flagged in the Connexion Authority save 
file. 
 
View and/or edit your default authority constant data. 
 
View authority records you submitted for review to which LC 
has responded (NACO users only) 

 

Express tab (CatExpress) 

Service 
Tab 

Button or Menu Item Result and Definition 

Express Search 
 
 
Basic 
 
 
Advanced 

Search WorldCat via CatExpress to retrieve records needed 
for copy cataloging. 
 
Basic search lets you retrieve records by standard number, 
title, or keywords. 
 
Advanced search lets you combine search terms with Boolean 
operators, limit search results by date, format, or language, 
limit results to Internet resources only, and specify sorting of 
results. 

 Other Get CatExpress records and check online documentation. 
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Service 
Tab 

Button or Menu Item Result and Definition 

 Download Export File 
 
 
 
 
 
 
 
 
 
Documentation 

Download a session-specific file of OCLC-MARC bibliographic 
records. Records are added to the file as a result of your 
actions during a session. You must have record export added 
to your profile. 
 
Note: Non-subscribers using CatExpress 
If you use CatExpress for a portion of your workflow, this 
activity is billed on a per-transaction basis, at the same rate as 
Connexion activity. 
 
Access the CatExpress User Guide on the OCLC web site. 

 

Dewey Services tab 

When you click this tab, click the button for one of the following services: 

• Dewey (full WebDewey) (requires a WebDewey subscription) 
 
Note: This selection now opens the full WebDewey service in standalone mode. WebDewey is 
not described here because it now has separate user documentation. To open Help, in the full 
WebDewey screen: 
 
Click Help in the navigation bar at the upper right. 
 
Note: Your Connexion session remains open separately at the same time as the WebDewey 
session. You can log off Connexion without logging off WebDewey session. When ready to log 
off WebDewey, click Logoff in the navigation bar. 
 

• Abridged Dewey (requires an Abridged WebDewey subscription) 
Opens the abridged version of Dewey from within the Connexion browser session. 
 
Note: Abridged WebDewey is also in the process of becoming part of the independent, 
standalone Dewey service, separate from the Connexion browser. 
 
The following description for Abridged WebDewey will apply while it remains within the browser 
application: 
 
Service 
Tab 

Button or Menu Item Result and Definition 

Dewey 
Services 
Abridged 
WebDewey 

Search button Search the database 

Search Options 
 
Abridged WebDewey 

 
 
Go to the Search Abridged WebDewey screen. 
Search the Abridged Dewey Decimal Classification. 



Requirements, Access, Interface Map   
 

 
 

 20160229 
 

 

39 

Service 
Tab 

Button or Menu Item Result and Definition 

 User Notes Go to the Search Abridged WebDewey User Notes 
screen. 

 Browse button Go to the Browse Abridged WebDewey screen. 
Browse Options 
 
Abridged WebDewey 

 
 
Go to the Browse Abridged WebDewey screen. 
Browse the Abridged Dewey Decimal Classification. 

 Create button Go to a User Note workform. 
Create Options 
 
User Notes 

 
 
Go to a User Note workform. 
Create notes that apply to specific DDC numbers, to 
types of material you catalog, or to library practices. 

 Show button Go to the Active Records screen. 
Show Options 
 
Active User Notes 
 
 
Introduction to the 
Abr. DDC 
 
Glossary – Abr. DDC 
 
 
Reloc. & Discontin. – 
Abr. DDC 
 
Show Tables – Abr. 
DDC 
 
Start Dewey-Only 
 
 
 
 
Start Cataloging 

 
 
Go to the Active Records screen. Find links to user 
note(s) you are currently viewing or editing. 
 
View the Introduction to the current edition of the 
Abridged Dewey Decimal Classification. 
 
View the Glossary for the current edition of the 
Abridged Dewey Decimal Classification. 
 
View changes from the previous edition of the 
Abridged Dewey Decimal Classification. 
 
View list of Abridged DDC Tables; jump to a specific 
table 
 
Appears when your current session is cataloging. 
Starts a new Dewey-Only session. 
Available only with an OCLC cataloging 
authorization and a Dewey Services subscription. 
 
Appears when your current session is Dewey-Only. 
Starts a new cataloging session. 
Available only with an OCLC cataloging 
authorization and a Dewey Services subscription.  
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Service 
Tab 

Button or Menu Item Result and Definition 

General News button Go to the Search News screen. 
News Options 
 
Search News 

 
 
Go to the Search News screen. 
View OCLC announcements, news about products 
and services, release notes describing recent system 
updates, and information on planned system 
enhancements. 

 Admin button Go to the Preferences screen. 
Admin Options 
 
Preferences 
 
 
 
 
User Information 
 
 
 
 
Extraction Shortcuts 

 
 
Go to the Preferences screen. 
Customize the navigation bar and other system 
interface features. Change settings for the session 
inactivity timer. Set options for each service. 
 
Go to the User Information screen. 
View session information for use when requesting 
support. Enter or change contact information (your 
name, email, and phone number). 
 
Shortcuts for record creation. For use when you are 
not yet logged in to Connexion. To use a shortcut, 
you must add it to your browser toolbar. 

 Documentation 
button 

Go to a web page on the OCLC web site that lists 
Connexion documentation. Items listed are web-
accessible files in PDF format. View the 
documentation online or print it for offline reference. 
The page also lists documentation on other OCLC 
cataloging services. 
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7. Help and technical support 

Context sensitive help 

Action 
At the top right corner of the screen, between Home and Contact, click Help.  
A Help window opens to display the help topic appropriate to the context. 

 

Search for a Help topic 

 Action 
1 At the top of any Help window, find the Search Help button and text box. 
2 In the text box, type 1 or more words that indicate the concept or function you want help 

with. 
Then click Search Help. 

3 The system searches the Help index and returns the results in the current Help window. 
The results window contains either: 
A list of topics that match the term(s) of your search. 
Or 
A message that your search matched no Help topics. The message includes tips for 
searching Help. 

4 If you receive a list of topics, click the hyperlinked title of the topic you want to view. The 
topic appears in the Help window. 
If you receive the message Items found: 0, retry the search. 
To improve results, enter fewer search terms or enter a synonym for your search term. 

 

Searching tips for Help 

• When you search Help, you search an index of terms drawn from the topics (not the full text of 
the topics). 

• The index contains: terms from the topic titles, terms from section headings within topics, and 
index terms assigned to each topic by the Help author. 

• Combine terms. Type the terms, separated by spaces. A space is treated as a Boolean AND; 
the system retrieves only topics that match all the terms you enter. OR and NOT are not 
supported. 

• Right truncation. To broaden a search, enter the beginning of a term, followed by the 
truncation symbol (an asterisk). Example: extract* 

• Wildcards not supported. The Help search function does not support use of wildcard symbols, 
such as the question mark (?) or pound sign (#) to substitute for characters within a term. 
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Get technical support via email 

 Action 
1 At the top right corner of the screen, click Contact. 

The Contact Support window appears. 
2 Indicate the type of message you want to send. 

A the top the window, under Indicate the type of message, select an option button: 
 Suggestion/Enhancement 

Or 
 Problem/Question 

3 Indicate who should receive the message. 
Under Choose a recipient for this message, select the appropriate option button: 
 Select OCLC Support to send the message to OCLC’s Customer Support 

Department. 
Or 

 Select Any E-mail Address to send the message to an address you specify. In the 
text box, type a valid email address. To send the message to more than one recipient, 
separate additional addresses with semicolons. 

4 Enter the message text. 
In the large text box, type a problem description, question, enhancement, suggestion, or 
comment. 

5 Provide contact information. 
 In the box labeled E-mail Address, type your email address. 
 In the box labeled Contact Name, type your name. 

Note: You do not need to supply your email address and name if you have already done 
so on the User Information screen. To view the User Information screen, on the General 
tab, under Admin Options, click User Information. 

6 Accept telephone contact. 
At the option labeled May support staff phone you about your message? 
 Leave the Yes button selected (recommended). 

Or 
 Select No if you prefer email responses only. 

7 (Optional) Request a copy of the email message. 
At the option labeled Would you like a copy of this message? 
 Leave the No button selected (default setting). 

Or 
 Select Yes to receive a copy of the message. 

8 (Optional) Print message before sending. 
To print the message: 
 Click the Print button at the top of the Contact Support window. 

Or 
 Press <Ctrl><P>. 

9  Click Send to send the message. 
Or 

 Click Cancel to clear the message. 
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Tips on using the Contact Support email form 

• Contact Support form in secondary browser window. When you click Contact, the form for 
composing and sending your message appears in a secondary browser window. The taskbar 
contains another item for this new instance of the browser software. 

• Use taskbar to return to unsent support request. If you interrupt work on a message in the 
Contact Support window (for example, to switch to the Connexion window to verify your 
description of the problem), use the taskbar to return to the Contact window. Do not click the 
Contact link again; you may lose any text already entered in the Contact form. 
 
Explanation. Most actions you take in Connexion cause the system to refresh the screen, 
including the header bar. If you click Contact on the redisplayed header bar, the system opens a 
new empty Contact form in the existing secondary window, overwriting any text you entered in 
the form. 
 

• Print form to save message text. Click the Print button at the top of the Contact form or press 
<Ctrl><P>. 

Error messages 

• Error messages alert you when Connexion cannot complete a requested action. 
• When possible, the message identifies the cause of the problem and, for problems that you can 

resolve, specifies a corrective action. 
• Connexion error messages are numbered to help support staff trace the reported problem and 

identify the cause. Message numbers appear at the end of the message text, in parentheses. 
• When requesting support via email or phone, include error message numbers in your 

description of the problem. 

OCLC Customer Support Department contact information 

Topic Information 
Hours 7:00 am-9:00 pm US Eastern time, Monday through Friday 
Telephone numbers USA and Canada: 1-800-848-5800 

International: +1-614-793-8682 
Fax 1-614-764-2694 
Web address http://oclc.org/support/default.htm 
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8. View OCLC system news 

About News 

What information is available in News? 

• General news and announcements for users of all OCLC services. 
• Announcements and news for users of OCLC Cataloging services. 
• News and announcements about other services accessed via OCLC Connexion. 
• In the System Updates category, provides information about the enhancements to OCLC 

Connexion and related web-based services. This News category replaces the link to version 
information formerly provided from the system home page. 

How can I access News?  

• On the General tab, click News. 
• At the Search News screen, you can search News for all current items, for all items in a 

category. 
• To find specific items of interest, you can search the titles or the contents of News items using 

keywords that specify your topic. 

View all News items 

 Action 
1 On the General tab, click News. 

The Search News screen appears. 
2 In the search form, leave the for text box empty. 

Do not specify a News category. 
3 Click Search or press <Enter>. 

The system displays a list of all current News items. 
 

View News by category 

 Action 
1 On the General tab, click News. 

The Search News screen appears. 
2 In the search form, leave the for text box empty. 
3 Limit the search to a News category. 

In the with Category box, open the list and click the News category you want to retrieve. 
Default setting: No category specified. 
 
News categories are: 
 Authorities 
 Cataloging 
 CatExpress 
 Digital Archive 
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 Action 
  Dublin Core 

 General 
 Local Holdings 
 System Updates 
 WebDewey 

4 Click Search or press <Enter>. 
The system displays a list of all current News items in the specified category. 

 

Find specific News items 

 Action 
1 On the General tab, click News. 

The Search News screen appears. 
2 Construct a search to specify the News item(s) you want to retrieve. 

 Type search term(s) in the for box. Spaces between words are treated as and 
operators; you can also combine terms with or and/or exclude terms with not. 

 Select the index to search from the list to the right of the for box. Click the arrow to 
open the list; then click Title or Message. Title is the default index. 

 Use truncation to expand a term to include variant endings. Or use truncation when you 
know only the first part of a term. Type the first characters of the term (include as many 
characters as you know); then type an asterisk (*). Examples: search*, digi*, edit* 

 Use character masking (wildcards) to expand a term to include variant spellings or 
when you are unsure of the correct spelling for part of a term. Type a question mark (?) 
or a number sign (#) in place of the character(s) you want to mask. Use the question 
mark to retrieve variants of 0 or more characters. Examples: col?r retrieves color or 
colour; int?net retrieves internet or intranet. Use the number sign to retrieve 
variants of exactly 1 character. Example: wom#n retrieves both woman and women. 

3 (Optional) Limit the search to a News category. 
In the with Category box, open the list and click the News category you want to retrieve.  
Default setting: No category specified. 

4 Click Search or press <Enter>. 
The system displays the News item(s) that match the search criteria. 
Clear text of News search  
 To clear the Search for text box, click Clear Search. 
 The index list retains the last index you selected. 
 The category list retains the last category you selected. 
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News search indexes 

Index (Iabel) Included Fields Example Tips/Why use? 
Title (ti:) Words in the titles of News items connexion Find a news item when you know 

the title. 
Determine whether a term is part of 
the title of a current news item. 

Message 
(me:) 

Words in the content of News 
items 

cutter* Find occurrences of term(s) for the 
topic you want in the body of a 
news item. 

 

View News search results 

Results display 

Number of Items 
Found 

Results Display 

No News items found The system displays the following message at the top of the Search News 
screen: 
No Records Found for Your Search 
Please change or simplify your search and try again. 

1 News item found The full News item appears. 
Up to 10 News items The system displays the message: 

[number] records found searching for [search query] in 
News 
The results screen lists the title, category, and date for each retrieved 
news item. 
All results appear on the screen. 

11 or more News 
items 

The system displays this message: 
[number] of records found searching for [search query] in News 
 The results screen lists the title, category, and date for each retrieved 

news item. The first 10 items appear on the screen. 
 The View List box lets you type an entry number to display 10 entries 

beginning with that number. The left and right arrow buttons let you 
move forward or back 10 entries. The View Record box lets you type 
an entry number to view the full record. 

 

Query display 

At the top of the first screen of results, the system displays a message that includes the number of 
News items retrieved and the query that produced results. The message provides feedback that lets 
you see how the system interpreted your search criteria. The display shows: 

• Each term preceded by an index label identifying the index in which it was searched. Example: 
ti: (“connexion”) 

• Term groups (multiple terms entered in the for box on the search form and searched in the 
same index). Example: me: (digital preservation) 
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• For queries limited by category, the name of the specified category. Example: ca: 
(General) 

Use the displayed query to 

• Diagnose causes for unsatisfactory search results. 
• Refine your search to improve results. 

 

Sort retrieved News items 

 Action 
1 Scroll to the top of the first screen of search results. 
2 Open the Action list and select Sort by Ascending Date or Sort by Descending Date or 

Sort by Category or Sort by Title. 
 

Move through list (View List and View Record jump bar) 

• The View List jump bar appears at the top and bottom of each screen of the results list. 
• The View Record jump bar appears at the top and bottom of each screen of the results list. 

 
Action How to 
Move forward 10 
entries 

Click the right arrow button (right of View List box). 

Move back 10 
entries 

Click the left arrow button (left of View List box). 

View 10 entries 
beginning with 
specific entry 

Type an entry number in the View List box and press <Enter>. 

View a specific 
record 

Click the hyperlinked entry number for the record you want to view. 
Or 
Type an entry number in the View Record box and press <Enter>. 

 

Move between records (View Record jump bar) 

• The View Record jump bar appears at the top and bottom of each record screen. 
• The record position indicator (Record_of_) appears at the top and bottom of each record 

screen. As you move through the records, the indicator changes to reflect your current position 
in the results list. 
 
Action How to 
View next record in 
list 

Click the right arrow button (right of View Record box). 

View previous 
record in list 

Click the left arrow button (left of View Record box). 

 



Requirements, Access, Interface Map   
 

 
 

 20160229 
 

 

48 

Action How to 
View a specific 
record 

Type an entry number in the View Record box and press <Enter>. 

Return to search 
results 

Click the Search Results button at the top or bottom of the record 
screen. 

 

Print screen of results 

 Action 
1 If the list includes multiple screens, jump to the screen you want to print. 
2 Click once in the frame that contains the results list. 
3 In your browser, on the File menu, click Print or on the toolbar click Print button. 
4 In the Print dialog box, click OK or press <Enter>. 

 

View a News item 

Fields in News items 

News item field Description 
Date The date that this News item became available. 
Title Brief description of the subject matter of the News item. 
Category Subject area for this News item. 
Message Content of the News item. 

 

Print News item 

 Action 
1 Display the News item you want to print. 
2 Click once in the frame that contains the News item. 
3 In your browser, on the File menu, click Print or on the toolbar click the Print button. 
4 In the Print dialog box, click OK or press <Enter>. 
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